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Introduction

This workbook has been prepared to help users who wish to create a user interface for a database in Access 2002 by customising Forms and creating Switchboards.  It is aimed at those who are confident in creating Forms in Access and who have an understanding of database design.  An understanding of how Queries are designed would also be helpful.

This guide can be used as a reference or tutorial document. To assist your learning, a series of practical tasks are available in a separate document. You can download the training files used in this workbook from the IS training web site at: www.ucl.ac.uk/is/training/documents

There is also a comprehensive range of online training in Access 2002 available via TheLearningZone at www.ucl.ac.uk/elearning

Calculated Controls

A Calculated Control uses an expression to obtain its information. An expression is a combination of operators such as = and +, Control Names, Functions and constant values (numbers). On a Form, Calculated Fields are calculated and displayed on each individual record. They are Unbound Controls i.e. they are not linked or ‘bound’ to a specific Field in a Table and the result that is displayed in them is not stored anywhere in the database.


Creating Calculated Controls

1. Open the Form on which you want to place the calculated field in Design View.

2. From the Toolbox, click the Text Box icon [image: image1.png]abl



.  

3. Click and drag over an area on the Form to draw the box.
The Text Box will appear on the form with an accompanying Label.

4. Click into the box and type the expression you wish to use to calculate the value in the Control (see Creating Expressions below for help on this).

5. Edit the Label caption as appropriate.

Creating Expressions

When creating expressions, observe the following rules:

· All expressions should start with an equals = sign.

· Round brackets ( ) and mathematical operators Plus +, Minus -, Divide / and Multiply * can be used in the usual way.

· Control Names of Controls on the Form can also be added, enclosed in square brackets.
For example, is based on the Table tbl_Doctor and there is a Control called Salary on the Form, this Control can be included as: [Salary]
Examples of Useful Expressions

=[Salary] + ([Salary]*0.1) 
adds 10% to the original salary figure

=Date()
displays today's date

=Now()
displays today's date or the current time

=[Price]*[Quantity]
multiplies a price field with a quantity field

=[Salary]/12
divides a salary by 12

=[Salary]+[Bonus]
adds a salary field to a bonus field

=[Income]-[Expenses]
subtracts an expense field from an income field

=[FirstName]&" "&[LastName]
concatenates the text from two different Controls (i.e.displays the text from two different Controls together in one text box) separated by a space

Helpful Hint

If you need more room to type an expression in the Control Source Property box, press Shift+F2 or right-click on the box and select  Zoom to open the Zoom Window.

Calculated Control Properties

Once you have created a calculated Control you can edit its Properties in the Property window.

Control Source
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The Control Source Property displays the Expression you created.
You can click on the Build Button [image: image2.png]


 to use the Expression Builder to help you create an expression.

Formatting

You can add appropriate formatting to your Control using the Format and Decimal Places Properties.  For example, a calculated Control based on the Salary field could have a Format Property of Currency and Decimal Places Property of 2.

Combo Boxes 

A Combo Box is a Control which will allow new values to be entered or a value to be chosen from a drop-down list that is displayed once the Control is selected. In many cases, it's quicker and easier to select a value from a list than to remember a value to type and it also reduces data entry errors.

The drop-down list in a Combo Box consists of rows of data. Rows can have one or more columns, which can appear with or without headings.  When a particular row is selected by the user, the value in the first column is entered into the box itself.  Combo Boxes can be created by either looking up the values from a Table, or by entering the values which are to be viewed in the Combo Box.

Helpful Hint

If a Control on a Form is bound to a Lookup Field, the Lookup Properties from the Table  will be carried forward to the Form Control and these Properties include creating a Combo Box.

Bound Combo Boxes

If a Combo Box is bound (linked) to a specific Field, the data entered in the Combo Box is entered in the specified Field (the Control Source).  The values in the drop-down list can either be looked up from a Table or Query or typed in as a Value List.

Creating a Combo Box which Looks up Values in a Table or Query

In Design View, ensure the Toolbox is displayed and the Control Wizard  [image: image3.png]


  is turned on.

6. Click on the Combo Box button  [image: image4.png]


  on the Toolbox.   

7. Click and drag an area on the Form to draw the Combo Box.

8. The Combo Box Wizard is displayed on your screen.

9. Select  I want the combo box to look up values in a table or query and click Next:
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10. Click on the Tables, Queries, or Both button to display a list of Tables and/or Queries:
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11. Select the Table or Query that is to provide the values for your Combo Box and then click Next.

12. Select the Field or Fields that contain the values you want included in your Combo Box. Click the  [image: image6.png]


 button to add them to the Selected Fields box on the right, or click on the [image: image7.png]3



 button to add all the Fields.

13. Click Next.

14. Set the width of the columns in the Combo Box as explained in the next dialogue box, then click Next.
15. Select Store that value in this field and click Next.
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16. In the final box, type in a name for your Combo Box and click Finish.


Creating a Combo Box based on a Value List

Repeat the first four steps as in the previous section and then:

17. Select I will type in the values that I want.
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Type in the number of columns you want for your list, then type in the values you want displayed in the boxes below:


19. Adjust the width of the columns if necessary.  Click Next.

20. Select Store that value in this Field and choose the Field in which you wish to store the data from the drop-down list.  Click Next.

21. In the final box, type in a name for your Combo Box and click Finish.


Unbound Combo Boxes

As well as entering data, Combo Boxes can be created to find records based on selections from the Combo Box. For example, a Combo Box with a drop-down list displaying Surname and First Name could be used to find a record for a specific staff member on a Form.  When creating these Combo Boxes, it is best to include the Primary Key field in the Combo Box as one of the columns.

To create an Unbound Combo Box which finds records, repeat the steps of  Creating a Combo Box which Looks up Values in a Table or Query on page 4 but:

22. Instead of selecting I want the Combo Box to look up the values in a Table or Query, 
Select Find a record on my form based on the value I selected in my combo box.  

23. Ensure that one of the fields you select is the Primary Key.


Editing an existing Combo Box

Once a Combo Box has been created using the Wizard, it can be edited using the Property window.
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The Property window below shows a Combo Box on a Form with the Record Source of tbl_Nurses.  
It looks up values from the WardNumber field in tbl_Ward and enters them in the Ward field of the tbl_Nurses.
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Modifying the Row Source

Preventing Duplicate Values

To stop duplicate values being shown in the Combo Box:

24. View the Properties window for the Combo Box.

25. Under the All tab, click on the Row Source Property.  The Build button [image: image10.png]


 will appear.

26. Click on the Build button to view the Row Source in the Query Builder window.

27. In the Query Builder window, double-click on the grey background to view the Properties window (see the diagram below).

28. In the Query Properties window, set the Unique Values property to Yes.

29. Close the Query Builder window and click Yes when you are asked if you want to save the changes.


Changing the Sort Order of a Drop-Down List based on a Table or Query

30. If the Combo Box is based on a Table or Query, the default sort order will be by Primary Key.  You may wish to change this to sort by another Field so that the items in the drop-down list appear alphabetically, making it easier to find a specific value.  To do this:

31. Open the Query Builder window as described above.

32. In the Sort row of the field you wish to sort by, select Ascending or Descending from the drop-down list:
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Close the Query Builder window and click Yes when you are asked if you want to save the changes.


Adding Values to a Value List

34. View the Properties window for the Combo Box.

35. Right click on the Row Source property and select Zoom from the menu.
A separate Zoom window will appear.

36. Enter your new values, encased in speech marks and separated by semi-colons.
e.g. Type: “Sister”;  “Staff Nurse”; “Nurse”; “Trainee”; 

37. Click OK.
The new values will be added to the Row Source.

Changing Control types

Controls can be changed from one type into another.  For example, Text box, Combo boxes and List Boxes can each be changed into the other two and Check boxes, Toggle buttons and Option button are all interchangeable in a similar way.  

Lookup Fields
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Just as Yes/No Fields are check boxes by default, Lookup Fields are Combo Boxes by default.  These can be changed to List Boxes which show all the available options at all times on the Form (as shown right).  This would be advisable only if you have enough room on the Form and usually works best where there are only a few options on the Value List.
Yes/No Fields
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When creating a Form using the Form Wizard or adding a Field from the Field List, a Check Box is the default Control type for a Yes/No Field.  Option Buttons are an alternative but Toggle Buttons are less clear and not advisable.

To change a Control type:

38. Right-click the Control and select Change To
39. Select the appropriate Control Type from the second menu which appears.  Unavailable options will be greyed out.

Command Buttons

A Command Button is used on a Form to start an action or a set of actions. For example, you could create a Command Button that opens another Form. A Command Button has an On Click Property which links to the Event Procedure or Macro which will run when the button is clicked.  

You can create over thirty different types of command buttons with the Command Button Wizard. When you use the Wizard, Access creates the Button and the Event Procedure for you.  Alternatively, you create a Command Button manually and select a Macro from the drop-down list of the OnClick Property to associate the Macro with the button.  See Macros on page 19 for details of how to create Macros.

Command Button Wizard

To create a Command Button using the Command Button Wizard:

40. Open the Form you want to add the button to in Design View.

41. Ensure the Toolbox is displayed and the Control Wizard  [image: image12.png]


  is turned on.

42. Click on the Command Button button on the Toolbox. 
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Click on the Form where you want to place the button.
The Command Button Wizard is displayed on your screen as shown left.

44. Select the relevant Category from the options on the left.

45. Select the required Action from the box on the right and click Next.  You may be prompted for futher details, such as the name of the Object you wish to open, depending on the Action chosen.

46. In the next dialog box, decide whether you want Text or a Picture on your button. 

47. If you selected Text, type in the text you want displayed on your button in the box.

48. If you selected Picture, click on the Browse button and locate the picture you want
Or
Select one of the Pictures listed in the dialog box.  Click on a Picture to see a sample of it on the left in the dialog box.

49. Click Next.

50. In the final box, type in a name for your Command Button.

51. Click Finish.

52. Switch to Form View to try out your new button.

Command Button Wizard Options

Most of the Actions available from the Command Button Wizard are fairly straightforward and could be carried out by the user of the database by using Toolbar buttons, Form Navigation buttons or by opening Database Objects from the Database Window.  Adding these Actions to a Command Button can be useful if, for example, you have hidden the Database Window or any toolbars (see Startup Options on page 17 for details) or if you wish to make it easier for the user to carry out a common action quickly and easily.  

However, the Open Form Action (available under the Form Operations Category) can be particularly useful because it is possible to apply a specific Filter to the records of the Form you are opening depending on the current record in the current Form.  For example, if you are in a Form shows patient details with their admissions as a Subform, you could use a button on the admissions Subform which would open the wards form and only show the ward for that particular admission (i.e. the ward that the patient was admitted to).

To do this:

53. Follow the steps 1 to 4 above to create a Command Button using the Wizard.

54. At steps 5 and 6, choose the Form Operations Category and select the Open Form Action from the list.

55. Select the appropriate Form from the list provided and click Next:
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56. Select Open the form and find specific data to display  and click Next:
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57. Select the appropriate Fields from the two Forms that are linked together and click Next:
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58. Complete the remaining steps 7 to 13.


Creating a Command Button manually

59. Ensure that the Toolbox is displayed and the Control Wizard is turned off.

60. Click on the Command Button button on the Toolbox.

61. Click on the Form where you want to place the button.

62. Select the new button you have created and view its Properties.

63. Edit the button by changing the appropriate Properties as listed below:

Property
Function

Name
Change the name of the button if appropriate

Caption
Type the text you wish to appear on the button

Picture
Click on the Build Button [image: image16.png]


 to the right of the Picture Property and use the Picture Builder to choose from a list of pictures Access provides or click on the Browse button to select one of your own.

On Click 
Select a Macro from the drop-down list to run it when the Command Button is clicked on in Form View.  See Macros on page 19 for details of how to create Macros.

User Instructions

There are a number of ways to guide users in the way that they view, edit and enter data in a Form.  For example:

64. Highlight important data by changing the Font of the Field Controls.

65. Highlight Fields that should be filled in by changing the Border of the Field Controls and re-ordering these Controls to the top of the Form.

66. Create additional Label Controls on the Form for instructions or additional information.

67. Apply Conditional Formatting to a Field (see the document IS-035 Advanced Queries and Reports for more details). 
68. Add Calculated Fields.

69. It is also possible to add information about specific Fields so that it appears in the Status Bar or to add a Control Tip to a Field so that it appears when the user hovers the mouse over that particular Control.  Details of how to do this are given below. 


Status Bar Text

If you add Descriptions to the Fields of a Table in Design View, these are automatically added to the Field Control when you create a Form using the Form Wizard or add Fields from the Field List.  This appears in the Status Bar Text Property of the Control in Design View.  In Form View, this text appears in the Access status bar when the user navigates to the relevant Field Control:
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Status Bar Text can be added or amended by clicking in the Status Bar Text Property in the Property Window and typing in the required text.


Control Tips

These can be added to a Control by typing the text you wish to appear in the Tip in the ControlTip Text Property of the Control.  The text will then appear in a pop-up Control Tip when the user of the Form hovers their mouse over the Control in Form View (as show for the Specialism Field Control below):
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Helpful Hint

 This type of user instruction is not very useful for users who navigate a Form using the mouse!

Switchboards

A Switchboard or a set of Switchboards provides a user-friendly interface to your database which guides the user through the process of entering, editing and manipulating data.  Switchboards can be created quickly and easily using the Switchboard Manager but it is advisable to think through and plan the various processes as a pen and paper exercise before proceeding with the actual creation of the Switchboards themselves.  Obviously, you will also need to create appropriate Forms and Reports before you can create the Switchboard Command Buttons which will open them.

Creating a Switchboard

70. From the Tools menu, point to Database Utilities and then click Switchboard Manager.

71. If you don’t already have a switchboard, Access asks if you would like to create one. Click Yes.

72. The Switchboard Manager dialog box will appear, as shown right, with one Switchboard already created and selected (the ‘Main Switchboard’).  Click Edit.

73. In the Edit Switchboard Page dialog box you can change the name of the Switchboard if you wish.  Click New.

74. In the Edit Switchboard Item dialog box, type the text you wish to appear next to the first switchboard button in the Text box (e.g. ‘Add a new doctor’)

75. Select an appropriate command from the Command drop-down list e.g. Open Form In Add Mode.
See the table overleaf for more details of what Commands are available and their uses.

76. In the third box, select the appropriate Object to run or open. Access will display a list of available items depending on the Command you chose previously.

77. Click OK.

[image: image19.png]hboard Item

Text [Rad a rew doctor =
Command ;

oo
‘Switchboard:

nin Add b
(Open Form n it Mods
Open Report

Design Appication

Exit Appication

Run Macro

Run Code.





78. Repeat steps 4 to 8 above until you have added all the items to the Switchboard. 
Note that you can only have a maximum of eight buttons on a single Switchboard. 
79. Click Close.

80. To view the Switchboard you have created, open the Switchboard Form that you have now created.  
You can find this in the Database Window under Forms.  For more details on how the Switchboard Manager creates Switchboards, see Understanding Switchboards on page 15.

Understanding Switchboard Commands
Below is a list of all the main Switchboard Commands you should be familiar with.
	Command
	Purpose
	What it does

	Open Form in Add Mode
	Adding new records 
	Opens a Form with only a new blank record available

	Open Form in Edit Mode
	Editing existing records and adding new records.
	Opens a Form with all existing records visible

	Open Report
	View or print a Report
	Opens a Report in Print Preview

	Run Macro
	Run a Macro 
	This depends on the Macro.  e.g. print a Report, run a Query, open a Form in Read Only Mode etc.

	Exit Application
	Close the database
	Closes all the Objects in the database including the database window.  Doesn’t exit Access.


Understanding Switchboards

The Switchboards that you create using the Switchboard Manager actually consist of a Switchboard Table and Switchboard Form which together enable you to view and use one or more Switchboards:

The Switchboard Table

When you create a switchboard with the Switchboard Manager, Access automatically creates a Table called Switchboard Items.  The Table is automatically updated as you create new switchboards and switchboard items and keeps a record of each of these, their names and what they do.  You should not edit this Table manually.  

The Switchboard Form

Access also creates a Form called Switchboard.  To view the Switchboard you have created, open the Form from the Database Window.  

The Switchboard Form has a default colour scheme and layout and has the name of the switchboard in the title bar and the name of the database in a Label Control above a set of buttons.  

If you open the Switchboard in Design View, you will notice that all eight potential command buttons are visible (but not the names of the Switchboard Items) and in Form View you will only see the appropriate number of buttons for the number of Items on the Switchboard.  This is because the Form is a generic Switchboard Form which changes in Form View according to the Switchboard displayed.  

You can make changes to the Switchboard Form but it is advisable to only change the look of the Form.  For example:

· change background colour of the Form and the fill colour of the Controls on the Form

· change the font formatting of any Labels

· change the text in or move the Label which contains the name of the database
Tip: because the font colour is white by default it is difficult to see when selected.  Change the font to a darker colour before trying to change the text.
· Add additional unbound Controls to the Switchboard (e.g. lines, images, rectangles etc.)
Don’t remove any controls from the Form or alter any of the Properties of the Controls, particularly the Command buttons and their Labels.
Design View
Form View
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Editing Switchboards

You can create new Switchboards or Switchboard Items, or edit existing ones, at any time by using the Switchboard Manager.

To create a new Switchboard:

81. From the Tools menu, point to Database Utilites and then click Switchboard Manager.

82. Click on New
83. For more details on using multiple Switchboards with a database see Working with multiple Switchboards on page 16.
To edit or delete an existing Switchboard:

84. From the Tools menu, point to Database Utilites and then click Switchboard Manager.

85. Click on the appropriate Switchboard and click Delete to remove the Switchboard or Edit.
If you choose Edit you can then change the name of the Switchboard, add an Item to it or edit an existing Item (see below).
To edit or delete an existing Switchboard Item: 

86. Follow the steps above to view the Items on an existing Switchboard.

87. Click on the appropriate Item and click Delete to remove the Item or Edit to make changes to it.
If you want to rearrange Items, click on the Item and then click Move Up or Move Down.
Helpful Hint

If you make changes to Items on a Switchboard while the Switchboard Form is open and displaying that Switchboard, you will not automatically see all the changes you have made.  Close the Form and re-open it to see the changes.

Working with multiple Switchboards
You can use the Switchboard Manager to create other Switchboards in addition to the first one you created.  For instance, you may wish to have a main Switchboard which acts as a ‘menu’ to link you to a number of other Switchboards which are for a particular purpose. 

Access only uses one Switchboard Form even if you have several Switchboards.  The command buttons and the text displayed next to them will vary depending on which particular switchboard is being displayed by the Form.  For this reason, to change from one Switchboard to another, you will need to create buttons on the Switchboards which take you to the other ones.  To do this, create a Switchboard Item with the Go to Switchboard command.  When creating these commands, always make sure that you are not creating ‘dead ends’ and that you can always get from any given switchboard to any other by some route!
Access automatically makes the first switchboard you create the default Switchboard.  The default Switchboard is the one that will be linked to the Switchboard Form when you initially open it.  

To change the default Switchboard:

1. Open the Switchboard Manager dialog box as described in Creating a Switchboard on page 14.

2. Click on the appropriate Switchboard to select it.

3. Click on the Make Default button.

Example of a multiple Switchboard interface

In the example below, the Main Switchboard is set to be the default switchboard and from it the user can navigate to the two other Switchboard.  These in turn have buttons which return the use to the Main Switchboard.  The user cannot navigate directly between the two additional Switchboards.  Switchboard items which take you to other Switchboards are shown as bold and the commands behind each Switchboard Item are shown in italics.


Startup Options

You can set a number of startup options to encourage users to use the Switchboard interface rather than the database window.  

Access can be set to automatically open your chosen form when you open the database.

To display the Switchboard Form as your startup form when the database is opened: 
88. From the Tools menu, select Startup.

89. In the Display Form box, select Switchboard from the drop-down list. 

90. If you do not wish users to see the Database Window when the database is opened, clear the Display Database Window check box.

Helpful Hint:

If you clear the Display Database Window check box but leave the Use Access Special Keys check box selected, you will still be able to access the database window by pressing F11.  The database window will also be available by clicking on the  database window icon [image: image22.png]


 on the toolbar. 

91. You can also elect to hide the menu and/or toolbars by deselecting the relevant boxes in the Startup dialog box.

92. Click OK.
93. To see the changes, close and re-open the database.


Helpful Hint: 
If you make a mistake and want to override the Startup changes you have made, close the database and hold down the Shift key while you re-open it.

Macros

A Macro is a list of actions stored as a Database Object and is used to perform repetitive tasks. When the Macro is run, the actions are automatically performed in order. Most tasks can be assigned to Macros. Macros can be run by double-clicking on them from the Database Window or they can be attached to a Command Button (see Creating a Command Button manually on page 11) or a Switchboard Item (see Understanding Switchboard Commands on page 15).


Creating a Macro to open a Form

94. Select Macros from the Objects List in the Database Window.

95. Click the New button to display a new blank Macro grid.

96. Click on the drop-down arrow in the Action column and select OpenForm from the list.

97. Press Tab to move to the Comments column.

98. Type in a description of what the Macro will do.

99. Some rows have appeared in the lower pane of the Macro window. These are the Action Arguments.

100. Click on the drop-down arrow in the Form Name box and select the Form you want the Macro to open.

101. Click on the drop-down arrow in the View box and select Form. 

102. Set the Data Mode as required (see below for more information).

103. Set the WindowMode to Normal.

104. Save and name the Macro.

Data Modes

There are three main data modes – Read Only, Add and Edit modes.  For details of Add and Edit modes see Understanding Switchboard Commands on page 15.  Read Only Mode allows you to view all the records but not to add any new ones or make any changes to the data.  Because you cannot use a Switchboard Command open a Form in Read Only mode, a Macro can be useful to achieve this.  Having created the Macro (as above) you then use the ‘Run Macro’ Command on the Switchboard Item and select the appropriate Macro from the list.

Creating a Macro with several Actions

A Macro can be created to combine a number of different Actions.  The following Macro will close a Form and open another Form, placing a value from a specific Control on the first Form into a specific Control on the other.  In the example below, to add a new patient to a particular doctor, you could create a Command Button on frm_doctor (which shows doctor details) which opens a new record in frm_patient (which displays patient details) and enters the StaffNumber for the appropriate doctor onto the new patient record.

The required steps are:

· Hide frm_doctor by setting the Visible Property to ‘No’.
The Form cannot be closed initially because we want to use data from the current record in a new patient record on frm_patient.  By hiding the Form it appears to be closed to the user.

· Open frm_patient in Add mode (i.e. displaying a new blank record)

· Set the value of the StaffNumber on the new record in frm_patient to match the StaffNumber value in the current record in frm_doctor

· Close frm_doctor
This is important because the current record in frm_doctor will not be saved or updated until you close the form.
· Move the cursor in frm_patient to the first Field Control required for data entry
This may not be necessary.  By default the Form will open with the first Field in the Tab Order selected.
To do this:
105. Create a new Macro as described in Creating a Macro to open a Form on page 19.

106. Add the following Actions to the Macro Grid, with the corresponding Action Arguments in the lower pane.  This will perform the actions as described in the steps above.  Details given in italics could be replaced with Form or Control Names of your choice.

	Action
	Arguments

	SetValue
	Item: [Visible] 
Expression: No

	OpenForm
	Form: frm_patient
Data Mode: Add

	SetValue
	Item: [Forms]![frm_patient]![StaffNumber] 
Expression: [Forms]![frm_doctor]![StaffNumber]

	Close
	Form: frm_doctor

	GoToControl
	Control Name: [PatientName]
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107. Save the Macro with an appropriate name.

108. Create a Command Button on frm_doctor and add the Macro to the On Click Property of the button.  See Creating a Command Button manually on page 11 for details.

Creating a Macro with Conditions
You can create a Macro which only performs the Actions in certain circumstances.  For example, you could design a Macro which displays a warning message when the number of patients on a ward might exceed the number of beds.  Different messages could be displayed for different situations.  The Condition would commonly specify what value or range of values should be in a particular Control.  The Condition should be entered in the Condition column next to each Action that is dependent on it.  The Condition column is not visible by default: it can be displayed by clicking on the Conditions toolbar button [image: image24.png]


.

Macro to display different messages depending on beds available

The following Macro could be attached to the After Update Property of the NumberOfPatients Field Control.
	Condition
	Action
	Argument

	[NumberOfBeds]-[NumberOfPatients]<0
	MsgBox
	Message: You have overallocated patients…

Type: Critical

	[NumberOfBeds]-[NumberOfPatients]<0
	StopMacro
	

	[NumberOfBeds]-[NumberOfPatients]=0
	MsgBox
	Message: There are no beds left on this ward
Type: Warning

	[NumberOfBeds]-[NumberOfPatients]=0
	StopMacro
	

	[NumberOfBeds]-[NumberOfPatients]<=2
	MsgBox
	Message: There are less than 3 beds left…
Type: Information

	[NumberOfBeds]-[NumberOfPatients]<=2
	StopMacro
	


In this example, the Macro is run after you change the value in the NumberOfBeds Field Control and then leave the Field (After Update).  The 6 lines of the Macro given above will carry out the following Actions:

· It checks if the value in NumberOfPatients is greater than the value in NumberOfBeds.  If this is the case (i.e. the Condition is met), a Message Box is displayed and then the Macro is stopped (using the StopMacro Action).  

· If the Condition is not met, the Macro continues to run and checks if NumberOfPatients is equal to NumberOfBeds.  
If the Condition is met a different Message Box is displayed and the Macro is stopped.  

· Finally, if the Macro is still running (i.e. neither of the previous two Conditions were met), the Macro checks if the value in NumberOfBeds is greater than the value in NumberOfPatients by two or less and displays another message if the Condition is met.  The last line stops the Macro.
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Macro as described above showing first line Arguments
Message Box the first line would create


Arguments for Message Boxes

A Message Box is a standard Windows dialog box with an OK button which closes the Box.  The Arguments are as follows:

Message
Type the message you wish to appear in the box.

Beep
Set to ‘Yes’ or ‘No’ depending on whether you want a beep to sound.

Title
Type the wording you wish to appear in the Title Bar

Type
This generates a symbol which appears next to the Message text.  For example, the ‘Critical’ type displays a cross in a red circle (see below).  Experiment with the different options.

Custom dialog boxes

You can can create a custom dialog box which allows you to open a Form to display specific data based on a set of criteria.  This is a similar concept to using a parameter query with a Form, the difference being that if you design the dialog box yourself you can use a Combo Box (drop-down list) from which the user can select criteria, thus minimising the chances of error and reducing the amount of typing required.  For example, you could create a Custom Dialog Box to view Nurses details for Nurses on a particular Ward.


Creating the Dialog Box

109. The Dialog Box should be a simple Form without any of the usual elements that are needed to select and browse records.  To achieve this:

110. Create a new Form in Design View.

111. In the Form Properties dialog box, set the following Properties (they are all on the Format Tab):

· Caption (set to a suitable Caption for the Title Bar of the Dialog Box)

· Default View: Single Form

· Scroll Bars: Neither

· Record Selectors: No

· Navigation Buttons: No

· Dividing Lines: No

· Border Style: Dialog


Although the Form itself is Unbound i.e. has no Record Source, the Combo Box needs to display the data from the appropriate Field(s).  As with all Combo Boxes, the Primary Key Field should always be included as well as any other Fields needed to make the data listed meaningful to the user.  In this example, it should be based on the WardNumber and WardName Fields from tbl_ward:

112. Create a Combo Box using the Wizard as described in Creating a Combo Box which Looks up Values in a Table or Query on page 4. 

· Use a meaningful instruction for the user as a Label e.g. Select a Ward from the List

· Rename the Combo Box to something meaningful, for example ComboWard.  This can be done by typing a suitable Name in the Name Property which is on the Other Tab of the Property Dialog Box.

113. Create a Command Button using the Wizard which will close the Form as described in Command Button Wizard on page 9.  Use the text Cancel on the Button.

114. Name and save the Form with an appropriate name e.g. frm_Select_Ward.

115. Check that the Combo Box displays the appropriate data and that the Cancel Button closes the Form.


Creating the Query and Form

116. The next step is to create a Query which uses the value selected in the Combo Box as it’s criteria, in this case to determine which Nurses to display depending on the Ward selected.

117. Create a Query in Design View including all the necessary Fields you wish to display, including the Field which is the Bound Column of the Combo Box (in this example it is the WardNumber Field).

118. Add any Criteria, Sorting etc. as required.

119. In the Criteria row of the WardNumber Field, enter the following Expression:
Forms![Form Name].[ComboBox Name] substituting the appropriate Names for the Form and the Combo Box.  
In this example it would be: Forms!frm_Select_Ward.ComboWard
120. Test the Query by opening your Custom Dialog Box and select a specific Ward from the Combo Box.  Run the Query: it should display the Nurses for the appropriate Ward.

121. Save the Query

122. Use the Form Wizard to create a Form based on your Query.


Creating and attaching the Macro

You now need to create a Macro to attach to the OK button on your Dialog Box.  This will hide the Dialog Box from the user and then open the Form to display the appropriate records based on the value chosen in the Combo Box.  It will then close the Dialog Box.  

Helpful Hint

As with the earlier Macro example described in Creating a Macro with several Actions on page 20, the Dialog Box cannot be closed before the Form is opened because the value selected in the Combo Box would not be available to use in the Query.  By hiding it, it appears closed to the user from the start.

The details for the Macro are given below.  You can substitute the Form Name with your own:
	Action
	Arguments
	Description

	SetValue
	Item: [Visible] 
Expression: No
	Hides the current Object (i.e. the Dialog Box)

	OpenForm
	Form: frm_Nurse_by_Ward
Data Mode: Edit
	Open the Form to display the Nurses records

	Close
	Form: frm_Select_Ward
	Closes the Dialog Box


123. Create the Macro as above and save it with a suitable name.

124. Test the Macro by opening the Dialog Box and selecting a value from the Combo Box.  When you run the Macro, the Dialog Box should ‘disappear the Form should open and display the appropriate data.

125. Attach the Macro to the On Click Property of the OK Button of the Dialog Box as described in Creating a Command Button manually on page 11.


















































































































NURSES AND WARDS


View available beds�Open Report (rpt_beds_available)


Find a nurse and edit details �Open Form in Edit Mode (frm_nurse_search)


Return to Menu�Go to Switchboard (Main Switchboard)





DOCTORS AND PATIENTS


Add new doctor�Open Form in Add mode (frm_doctor)


View all patients�Open Form in Edit Mode (frm_patient)


Return to Menu�Go to Switchboard (Main Switchboard)





MAIN SWITCHBOARD


Manage Doctors and Patients�Go to Switchboard (Doctors and Patients)


Manage Nurses and Wards�Go to Switchboard (Nurses and Wards)


Exit�Exit Application





Double-click here to view Query properties





Sort in ascending order by NurseName





This is set to Yes meaning that, when entering data, you can only enter values on the list.





This defines which fields are used in the drop-down list.  If the Row Source is a Value List, the list will be displayed here.  See � REF _Ref72581291 \h � \* MERGEFORMAT ��Modifying the Row Source� below on how to edit the Row Source.





The Combo Box is based on a Table or Query. (Alternatively, this could be set to Value List.)





Field where the value is stored.
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